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Prez Says: Ron Cowger 

 
Wow, here we are in May already!  It seems like just a few weeks ago we on the Board of Directors 
began talking about the upcoming KEGaBuck$ Auction and felt comfortable that we still had 
plenty of time to prepare for the big, annual event.  Suddenly it’s just a few weeks away and there is 
still a lot to do to get ready.  One of the primary things that we have to do is collect bid items for the 
auction.  As in past years, we are seeking donations of items that you may have stuck away in the 
closet or drawer some place but no longer need.  We are seeking software, hardware or other com-
puter-related items that may be of use to your fellow members.  In order to help ensure that we have 
items that will generate interest, the Board of Directors has developed some guidelines for items 
contributed.  I am attaching a copy of those guidelines to the end of this newsletter (SEE PAGE 3).  
If you have software or hardware items to donate, please give them to any member of the Board or 
to a SIG leader and your contributions will be forwarded to the folks who are setting up the Auc-
tion. 
 
I want to offer a big “Thank you” to Sally Ann Mowrey for putting on the main presentation at the 
April General Meeting.  She had to come up with a topic very quickly when Carl Von Papp was 
forced to cancel his presentation very late. Unexpectedly, BCC put him on the teaching schedule 
the same night as our meeting.  Sally Ann gave an interesting presentation on Zoom Text Express, a 
utility that allows one to expand text shown on a computer screen to make it much more legible.  It 
was a flexible and versatile application and Sally Ann demonstrated all aspects of its functions.  
Thanks for stepping up with an interesting presentation at the last minute.  Great job! 
 
The presentation at the May meeting will be given by Mark Miller of Microsoft.  He will speak to 
us again about PC Security, a very important and always changing area of concern.  Mark last 
spoke to us in February of 2007 and I know that you will agree that many things have changed in 
the world of malware since then.  I hope each of you will come to this presentation to learn what 
steps you need to take to protect your computer(s) from attack.  I’ll certainly be there and will be 
taking notes. 
 
This month we are adding a new feature to our monthly newsletter.  We are adding two MS Office 
tips, one for using Word and the other for Excel, to expand our knowledge of these applications 
(SEE PAGES 4, 5 & 6).  The tips are provided to us by Sharon Parq Associates and I think that 
you will find them quite useful.  If you want access to additional tips from the company, you can go 
to their websites at word.tips.net or excel.tips.net.  I think you’ll find the information interesting and 
useful. 
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So far this year, fifty-five computer enthusiasts have joined or renewed their memberships in 
KEGS.  Thanks very much for your confidence in the organization.  We finished 2009 with 
sixty-three members in our group.  We still need to focus on building our membership through-
out 2010.  I encourage those of you who have not yet done so to renew your memberships as 
soon as possible.  Renewal forms are available from John Tate, our Treasurer, or you can fill out 
the form on the KEGS web site, print it out and send it along with your check to the address 
shown on the form.  An even easier way would be to bring your completed form and your check 
to the next General Meeting and give it to John there. 
 
That’s it for now.  I hope to see each of you at your favorite SIG and at the May General Meet-
ing.  I wish you happy and safe computing! 

 
 

 
 
 
 
 
 
 
 
 
 
 
 

 

Ron Cowger 
President 



 
AUCTION DONATION GUIDELINES 

 
1.  Only software that runs on operating systems of Windows XP or newer will be 
accepted.  
 
2.  No computer add-in cards that plug into an ISA bus will be accepted. 
 
3.  Donated items need to be complete enough to be easily used by the buyer.  
Each item should be in the original box if possible.  If necessary, a substitute box 
may be used.  Items that came with installation software and documentation should 
have those items in the box with the item. 
 
4.  Items that do not receive bids during the Auction will not be held over to the 
next Auction.  Members who donate items are requested to put their names on the 
items and to take any items not receiving bids home with them at the end of the 
Auction. 
 
5.  Any PCs that are donated should be based on at least a Pentium IV with a speed 
of 1.6 GHz or higher. 
 
6.  Printers need to have Windows XP or newer drivers and cartridges should be 
available.  USB connections are preferred but not required. 
 
7.  No CRT monitors will be accepted. 
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Prez Says: continued 



Deleting a Hyperlink 
Part of Microsoft Excel’s compatibility with the Web is to allow you to define hyperlinks in your 
workbooks. There may come a time when you no longer need a particular hyperlink. Fortunately, 
deleting a hyperlink in Excel is very easy to do. All you need to do is follow these steps: 

1. Right-click on the hyperlink. Excel displays a Context menu. 
2. Choose the Hyperlink option from the Context menu. Excel displays a submenu. 
3. Choose Remove Hyperlink from the submenu. Excel dutifully removes the hyperlink. 

You should note that in some versions of Excel (such Excel 2003 and Excel 2007) there is a Remove 
Hyperlink option directly on the Context menu displayed in step 1. If this is the case, consider your-
self fortunate—you can directly remove the hyperlink without the extra steps. 

Don’t make the mistake of thinking that you can get rid of a hyperlink simply by clearing a cell 
(moving to the cell and pressing DEL). You can do this in the newer versions of Excel, but you can-
not in the older versions. If you do this, the hyperlink text is gone, but the hyperlink itself is still lurk-
ing in the background. If you type some information in the cell again, you will notice it is underlined, 
indicating it is still a hyperlink. The reason for this is because Excel considers the hyperlink to be a 
format of the cell. Pressing DEL only clears the contents of the cell, not its format. You can use other 
editing techniques to get rid of a hyperlink, however, provided those techniques result in getting rid 
of formatting or overwriting the formatting. 

Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Microsoft Excel 
tips can be found online at http://excel.tips.net. 
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Excel Tip of the Month 



Mixing Column Formats On a Page 
It is not uncommon to have a document that mixes different column layouts on a single page. For in-
stance, let's assume you have a five-page document, and you want to format the center part of page 
two as three columns. You want the rest of the document to remain a single column. To overcome this 
formatting challenge, you can follow these steps if you are using Word 97 through Word 2003: 

1. Select the text that will appear in the columns. 
2. Choose the Columns option from the Format menu. Word displays the Columns dialog box. 

 

 

 

 

 

 

The Columns dialog box. 

3. In the Number of Columns field, specify the number of columns you desire. 
4. In the Apply To box, make sure it says Selected Text. 
5. Click on OK. Word places the selected text into its own section and sets it in the number of 

columns you specified. 

If you are using Word 2007, then the steps are a bit different: 

1. Select the text that will appear in the columns. 
2. Choose the Page Layout tab for the ribbon. 
3. In the Page Setup group, click the Columns drop-down list. 
4. Pick the number of columns you want to use for the selected text. 

Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Microsoft Word 
tips can be found online at http://word.tips.net. 
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Word Tip of the Month - also see next page 



Mixing Column Formats On a Page 
It is not uncommon to have a document that mixes different column layouts on a single page. For in-
stance, let's assume you have a five-page document, and you want to format the center part of page 
two as three columns. You want the rest of the document to remain a single column. To overcome this 
formatting challenge, you can follow these steps: 

1. Select the text that will appear in the columns. 
2. Choose the Page Layout tab for the ribbon. 
3. In the Page Setup group, click the Columns drop-down list. 
4. Pick the number of columns you want to use for the selected text. 

Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Microsoft Word 
tips can be found online at http://word.tips.net. 
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Word Tip of the Month - continued 



KEGS General 
Meeting 
And Associated SIGs 

KEGS T-shirts 
Remember, you score extra KEGABUCK$ 
when you wear your KEGS shirts to SIGS 
and the General Meetings!  (NOTE: This 
extra credit is not honored at the PIG SIG.) 

We still have a few left of various sizes.  
Then we will order more.  So why wait?  
Pick yours up at the next general meeting. 

Day of Month Time Location  SIG / Email contact  SIG Leader 

2nd Monday 6 PM - 7 PM Kirkland Teen Union 
Building 

Technology Corner 
   betacode@hotmail.com 

Steve Fondren 

2nd Monday 7 PM - 9 PM Kirkland Teen Union 
Building 

KEGS General Meeting  

2nd Monday 9:30 PM - ? 
PM 

Outback Steakhouse 
12120 NE 85 th, Kirkland 

Pig SIG 
   sallyannmowrey@msn.com 

Sally Ann Mowrey 
206-996-5635 

General Meetings at the Kirkland Teen Union Building - 348 Kirkland Ave., Kirkland, WA 98033 

DRIVING INSTRUCTIONS: From I-405, take the N.E. 85th ST. exit (exit number 18) toward KIRK-
LAND (headed West).  Immediately move to the center lane and take a left at the first light onto 
Kirkland Way (If you went right you would be on 114th Ave NE).  Just stay on Kirkland Way and it 
will turn into Kirkland Ave.  

The Kirkland Teen Union Building is part of a string of connected buildings.  Right at the street is 
Kirkland's Performing Arts Center, then comes the Kirkland Senior Center and farthest from the 
street is The Kirkland Teen Union Building. 

There is a parking area to the West of this building but you can also park in the Kirkland Library's 
covered parking area just a little farther to the West ( 1/4 block past the Performing Arts Center). 

mailto:betacode@hotmail.com�
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KEGS SIG Meetings: 
KEGS T-shirts 
Remember, you score extra 
KEGABUCK$ when you wear 
your KEGS shirts to SIGS and the 
General Meetings!  We still have 
a few left of various sizes.  
Then we will order more.  So 
why wait?  Pick yours up at the 
next meeting. 

NEW SIG CHART 
Notice that this SIG chart  no longer lists actual dates.  Please check our KEGS calendar (at 
http://www.kegs.org/Calendar.html) for actual dates AND POSSIBLE CANCELLATIONS of 
the upcoming meeting that you want to attend. 

Contact the SIG leaders to find out what presentations that they have planned for their up-
coming meetings. 

Meetings at the North Bellevue Community / Senior Center - 4063  148th Ave NE, Bellevue, WA  

Day of Month Time Location  SIG / Email contact  SIG Leader 

1st Wednesday 7 PM - 9 PM Conf. room D Seattle Internet User Group 
   seasigi@kegs.org 

Marianne Wilkins 

2nd Tuesday 7 PM - 9 PM Conf. room D WIN 95/98/XP/?? 
   daviddodge1@compuserve.com 

David Dodge 

2nd Wednesday 7 PM - 9 PM Conf. room D Laptop SIG 
   ctheprof@aol.com 

Carl Von Papp 
425-643-1398 

3rd Tuesday 7 PM - 9 PM Computer Lab Computer Support SIG - N. Bellevue 
   j_m_mraz@hotmail.com 
(Computer repair & maintenance) 

Joe Mraz 
425-747-2433 

3rd Wednesday 7 PM - 9 PM Conf. room D Small Office / Home Office 
   r_cowger@prodigy.net 

Ron Cowger 

4th Tuesday 7 PM - 9 PM Conf. room D Digital Imaging SIG 
   sallyannmowrey@msn.com 

Sally Ann Mowrey 
206-996-5635 

4th Wednesday 7 PM - 9 PM Conf. room D HTML SIG 
   jackbewitch@comcast.net 

Jack Beslanwich 
206-723-9960 

2nd Tuesday 7 PM - 9 PM Conf. room D Digital Video SIG 
   jackbewitch@comcast.net 

Jack Beslanwich 
206-723-9960 

http://www.kegs.org/Calendar.html�
mailto:jackbewitch@comcast.net�
mailto:seasigi@kegs.org�
mailto:daviddodge1@compuserve.com�
mailto:ctheprof@aol.com�
mailto:j_m_mraz@hotmail.com�
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mailto:jackbewitch@comcast.net�


Please note that the KEGS Board meetings are not held at our General Meeting or SIG  
meeting locations 
• KEGS Board Meetings are currently held at Executive Real Estate’s Bellevue office at 20 

Lake Bellevue, Bellevue, WA.  (Board meetings are public and open to anyone who wants 
to attend.) 

SIG Meeting Locations: 

Finding our primary SIG meeting location 
 

DRIVING INSTRUCTIONS: Thanks to the improvements to SR 520, you may now use the new 
NE 40th St exit. If you are driving towards Redmond, exit and turn left to go over the over-
pass. If you are coming from Redmond, exit and turn right. Go to 148th Ave NE, and turn 

right. In very short order, you will see the North Bellevue Community / Senior Center sign on 
the left side of the roadway. 

KEGS was formed in late 1996 to meet the needs of personal computer users in the Greater 
Seattle Area. KEGS is a nonprofit organization that holds its general meetings on the second 
Monday of each month.  
In addition, KEGS sponsors a number of special interest groups (SIGs) that meet regularly 
to share common interests, learn new techniques, and resolve questions about the use of per-
sonal computer hardware, accessories, or software. 

History & Contact info: 

For a detailed listing of our SIG’s, updated 
information about KEGS activities, and 
more, please see our web site at:  
 
              http://www.kegs.org. 

 Contact us at: Email: info@kegs.org 
 The Komputer Enthusiasts of Greater Seattle  
 PMB# 195  
 677 120th Ave NE, Suite 2A  
 Bellevue, WA 98005     
 Or call 425-747-2433 before 9 PM 

To submit articles or software reviews for incorporation into this Newsletter, please send them 
to:   newsletter@kegs.org 
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